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Chapter 1

Certification Exam Development

Purpose of a Certification Exam
The key to making the Certification Business Model work is identifying candidates 
who are at least minimally acceptable in a domain of knowledge—that is, the spe-
cific area of specialized knowledge, skill, or ability. (See “Glossary of Common 
Exam Development Terms” on page 3 for more definitions and terminology. A certi-
fication exam is used to identify candidates who are qualified at no less than the tar-
geted pre-determined level of expertise. As such, a certification exam is a pass/fail 
instrument. There is no extra credit awarded for correctly answering an exam item 
that requires more knowledge or experience than the Minimally Acceptable Candi-
date (MAC) would be expected to possess. Therefore, when creating this kind of 
exam, you write the exam to assess at the level of the MAC.

Terms and Definitions
See “Glossary of Common Exam Development Terms” on page 3 for definitions of 
the common testing terms used in this book.

Validity
Validity measures the accuracy of the inferences made from an exam’s results. It 
answers the question, “are we measuring the knowledge, skills, or abilities that a 
candidate must possess to be truly qualified at our pre-established minimum level of 
competency?” In simple terms, it asks, “Are we certifying the right people?”

The analogy that best describes the concept of validity is archery and shooting at a 
target. A truly valid measurement hits the target dead center on the bull’s-eye. For 
example, if a goal of an exam is to measure knowledge of permissible cable types in 
a given networking situation, does the exam ask about which cable types may be 
used in that very situation? If yes, then a high degree of validity has been 
achieved—you hit the bull’s-eye. If the exam asks only which cable types may be 
used in general, a lesser degree of validity may have been achieved—you may have 
hit an outer ring on the target—close, but no bull’s-eye. If the exam asks about 
something other than cable types, then the quality of validity will be lacking—you 
will have missed the target altogether.

Reliability
Reliability refers to the accuracy and consistency of exam scores and pass/fail deci-
sions based upon them. Reliability is “repeatability.” It measures how close the 
same person would get to their first score the next time the exam is taken provided 

Validity is like shooting at a 
target. When the exam 
measures things you want 
to know when making a 
certification decision, it is 
like hitting the bull’s-eye. 
An exam that measures 
something else misses the 
target completely.
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that no further studying took place. It answers the questions, “How accurate and 
consistent is this score?” “How much does this score vary from what this person 
should have scored were this exam perfectly reliable?” and “How much can we 
trust this score?” In general terms, it asks, “How consistently are we certifying 
the right people?”

Like validity, reliability is a quality of an exam score. A reliable exam score is 
one that lets the examinee’s true abilities show through and thus is consistent 
from one sitting to the next. A less reliable exam is influenced by factors that 
have nothing to do with the topics being measured. As a result, less reliable 
exams produce scores that are less precise and that can vary widely for the same 
examinee from one sitting to the next. An unreliable exam reduces everyone’s 
confidence in the certification decision.

 The quality of reliability is like target practice. When practicing archery, the goal 
is consistency. The archer practices aiming each arrow at the same place each 
time, pulling back on the bow the same way each time, and releasing with the 
same motion each time. If successful, each arrow will strike the target at the same 
place each time. The tighter the grouping of arrows, the more consistent and reli-
able the result, the more confident you can be that the arrow landed where it was 
aimed. The valid use of an exam score is one where you can be confident that the 
bull’s-eye was where you want to aim. A reliable exam score is one that allows 
you to be confident that when you hit the bull’s-eye, that was where you were 
aiming.

Expectations—Why Are We Here?
We are here to create an exam from which valid, reliable—therefore, fair—certi-
fication decisions can be made.

An exam is composed of one or more exam items. Any exam is only as reliable 
or applicable as the items from which it is built. So, in order to create an exam 
that will yield reliable scores valid to our purpose, we must write effective, well-
crafted, applicable exam items. Our purpose is first to learn how and then to actu-
ally write the “effective,” “well-crafted,” “applicable” exam items from which 
our exam will be built.

Conclusion
All of the instructions and item writing guidelines in this book are designed to 
produce items that will perform well—that is, generate good statistics—so they 
will survive the exam development process, so they can be used on a final form 
of the exam. Closely adhering to the principles in this book will allow more of 
your questions to survive the reviews, beta exam, and item analysis process and 
contribute to an effective exam whose results are reliable and valid for use in the 
certification program.

Validity

Are we certifying the right 
people?

Reliability

Are we consistently 
certifying the right people?

Reliability is like target practice. It 
measures “repeatability.” When 
an exam is reliable, it is like being 
sure you will hit the target where 
you aimed. When an exam is not 
reliable, you can’t be sure where 
you will hit the target, no matter 
where you aim.
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Glossary of Common Exam Development Terms

Term Definition

answer cue (unintended answer cue) a hint that gives away the answer

answer option (option) a selection the exam taker may choose as a response to the stem

attachment exhibits, tasks, etc. accessible from, but not part of, the main item presentation

bias wording, phrasing or some other attribute of an item that advantages or disad-
vantages one subgroup of the population over another

borderline candidate a candidate who is qualified, but just barely qualified; a Minimally Acceptable 
Candidate (MAC)

candidate (certification candidate) person attempting to obtain a certification; an exam taker

congruence a measure of how well an item conforms to an objective

cut score the minimum passing score

differentiation the quality of separating those who can from those who cannot

distractor an incorrect answer option

domain a content area; a defined topic; the subject matter of the exam

examinee person taking the exam; exam taker

exhibit additional material needed to respond correctly to the stem that is too big or 
awkward to fit in the stem

item (exam item) a question, problem, or task which is part of an exam

item type a particular style of item, such as multiple choice, matching, fill in the blank, 
story problem, point and click, etc.

key (keyed response) a correct answer option

MAC a candidate whose ability levels meet but do not exceed any of the minimum 
standards set for the exam; a borderline candidate

objective the description/definition of a specific, limited area and level of knowledge, 
skill, or ability

psychometrician one who applies the principles of psychometrics; a testing expert

psychometrics the science of measuring human behavior (in exam situations)

relevance the importance or value of the content tested in an item

response an exam taker’s answer; result of an exam taker’s interaction with the exam 
item

stem the question or prompting portion of an exam item

task an interaction which the exam taker is instructed to perform

exam blueprint (blueprint) the plan defining the number and content of items on an exam

exam form one version of an exam with multiple, but equal versions
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Exhibit 1.2 
Exam Item Classical Statistics Report

Item 
Count

Item ID Item Type* Form Tried Right P-Value Point 
Biserial

90.0% 
Sig.

Reliability 
Index

Average 
Time

1 Demo.1.1.a.1 m3 beta 62 20 0.32 0.157 0.210 0.07 42.6

2 Demo.1.1.b.1 m4 beta 62 34 0.55 0.405 0.210 0.30 53.2

3 Demo.1.2.a.1 m2 beta 62 55 0.88 0.308 0.210 0.22 41.2

4 Demo.1.2.b.1 f beta 62 14 0.23 -0.137 0.210 -0.06 47.3

5 Demo.1.2.c.1 f beta 61 12 0.19 0.190 0.212 0.08 51.0

6 Demo.1.2.d.1 m5 beta 62 44 0.71 0.497 0.210 0.36 34.0

7 Demo.1.2.e.1 m1 beta 62 54 0.87 0.453 0.210 0.15 34.9

8 Demo.1.2.f.1 m1 beta 62 58 0.94 0.387 0.210 0.10 19.4

9 Demo.1.3.a.1 m1 beta 62 62 1.00 0.000 0.210 0.00 21.9

10 Demo.1.3.c.1 m1 beta 62 38 0.61 0.207 0.210 0.10 43.2

* Item Types:

tf = true/false, f = free response, m1 = multiple choice, one option correct, m2 = multiple choice, two options correct, m3 = mul-
tiple choice, three options correct, m4 = multiple choice, four options correct, m5 = multiple choice, five options correct, 

dd = drag and drop, pc = point and click, cg = complex graphical

p-value

The proportion of candidates who answered correctly

0.50 = 50% answered correctly

1.00 = 100% answered correctly

0.61 = 61% answered correctly

Point Biserial

Correlation Coefficient

An indication of which candidates answered correctly

1.000 = Perfect correlation (only knowledgeable 
candidates answered correctly)

0.500 = Knowledgeable candidates answered correctly in 
higher proportions than unknowledgeable 
candidates

0.000 = No correlation (knowledgeable and unknowledgeable 
candidates answered in equal proportions

-0.500 = Unknowledgeable candidates answered 
correctly in higher proportions than knowledgeable candidates

-1.000 = Perfect inverse correlation (only unknowledgeable 
candidates answered correctly)
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Exercise 1.2
Looking at the Statistics: Reviewing Beta Reports (the statistics we use)

Using the data in Exhibit 1.2, Exam Item Classified Statistics Report, answer the following 
questions:

1. Which item tells us the least about each candidate? _______________________________ 

    Would you want this item on your final exam? ___________________________________ 

    Why? ___________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________

2. Which item was missed more often by candidates of higher ability than candidates of lower

    ability? __________________________________________________________________

    Would you want this item on your final exam? ___________________________________ 

    Why? ___________________________________________________________________

__________________________________________________________________________

3. Which item would you rather have on your final exam, Demo.1.1.a.1 or Demo.1.1.b.1? 

__________________________________________________________________________

    Why? ___________________________________________________________________

__________________________________________________________________________

__________________________________________________________________________
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Chapter 2

Working with Objectives

What is an Objective?
An objective is a statement describing a demonstration, knowledge, or skill. Objec-
tives make up the bulk of the exam blueprint document (the plan for how to build 
the exam). Each exam objective defines a particular portion of the content, subject 
matter, or domain that is to be covered by the entire exam. Exam blueprints list each 
objective to be covered and how many items should be assigned to testing the con-
tent specified in each objective. Collectively, all the objectives in an exam blueprint 
define the overall exam content or domain. Indeed, the objectives and the blueprint 
tell us what and at what level to test with the items we write.

Where do Objectives Come From?
Exam objectives are generally created by subject matter experts (SMEs) during a 
Job/Task Analysis (JTA) or some other content matching process. A validation pro-
cess where additional SMEs check the work done in the JTA conference is often 
used to verify the appropriateness of the objectives produced in the JTA. The objec-
tives are then reviewed and weighted by yet other SMEs as part of the blueprinting 
operation. The weighting procedure allows SMEs to indicate how important each 
objective is to the overall certification decision, including which objectives would 
best be used to differentiate between qualified and unqualified individuals. The 
combined weight assigned to each objective is used to determine the number of 
items to write for that objective. This allows the exam to place emphasis on each 
objective according to the level of importance assigned to it by the blueprint SMEs.

The process of creation, validation, and weighting of objectives provides evidence 
that the scope of the exam is consistent with the expectations one would have for a 
candidate certified in the overall exam domain. This, then, becomes evidence that 
certification decisions based upon scores obtained from this exam are valid. It is the 
process we use to ensure that what our exam covers and the proportions in which it 
is covered are fair.

An objective is what we aim 
at when writing exam items. 
An objective describes the 
knowledge, skill, or ability 
we are trying to measure in 
the item.
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Writing to Objectives
In order to write items that will conform to the specifications of the exam blue-
print, you will have to know how to work with objectives. In order to write items 
that are fair—that test the material specified in the objectives—you will need to 
be able to analyze and interpret objectives for certain information.

The Parts of an Objective
A complete exam objective is one that includes a performance, conditions, and 
completion criteria. From these a cognitive task may be inferred. When writing 
items for an exam to be administered in a computerized testing center, there is an 
additional requirement: it must be possible to present, perform, and score the 
item in a testing center environment.

Analyzing an Objective
Writing items that test the content specified in their objectives, at the specified 
level of difficulty, is the goal of item writing. That is how you create items that 
differentiate at the proper level. That is how you make exams that are fair. To 
meet this goal, item writers must be able to analyze and interpret what each 
objective is specifying.

There are three steps to analyzing an objective:

1. Identify the various parts of the objective

2. Deduce and clarify the cognitive task

3. Determine the level of thinking required

A complete objective contains a 
performance, conditions, and cri-
teria. Also implied in the back-
ground is a cognitive task.

Table 1: 

Cognitive Task Example

Recall (declarative knowledge)

2. Specify parameters • Specify names, dates, values, rules, formulas, policies, 
etc.

• List the dir command arguments that deal with file 
attributes.

• Name the seven layers of the OSI mode.

3. Define terms • Define various WAN terms.

• Define common Personal Computer terms, including 
RAM, ROM, CPU, Bus, I/O, hard drive, and SIMM

4. Recognize things • Visually recognize objects, locations, and displays.

• Recognize events, situations, meaning, characteristics 
and capabilities.

• Classify objects by category.

• Identify the major families of CPU chips by sight.

• Know where the CPU chip is installed on the model 
4750 100 Mbit ISA bus motherboard.
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5. Describe things • Describe the purpose, features, and function of a par-
ticular thing in a particular context.

• Describe the relationship between similar or related 
things.

• Identify examples of a specific thing.

• Locate specific things within a picture or context.

• Distinguish between specific kinds of things.

6. Explain actions and 
events

• Explain when and how to perform a particular proce-
dure.

• Know how and when to take a specific action or set of 
actions.

• Explain why it is important to perform a particular pro-
cedure.

• Explain issues that must be considered when perform-
ing a specific procedure.

• Explain how a system works.

• Explain the relationship between related things.

• Explain the principle of _________.

• Explain why an event takes place.

• Explain why something is important.

Reasoning (procedural knowledge)

7. Analyze situations • Given a problem situation, analyze the situation and 
infer the most likely cause of the problem.

• Given a problem situation, analyze the situation and 
explain what happened.

• Given a problem situation, analyze the situation and 
identify issues to consider when deciding what course 
of action to take.

8. Select appropriate 
actions

• Given a scenario, select the appropriate course of 
action.

• Given a scenario, select the appropriate tool, utility, 
file, or command.

• Given a scenario, select the appropriate resource, 
method, algorithm, configuration, or design.

9. Decide what to do 
next

• Given a problem solving scenario, decide what to do 
next.

• Given a critical fault on a switch somewhere on your 
WAN, decide on the appropriate next step to resolve the 
fault.

10.Order steps • Given a list of installation steps for an ACME switching 
product, place the steps in order.

• Given a problem solving scenario and a list of diagnos-
tic steps, place the steps in order.

Table 1:  (Continued)

Cognitive Task Example
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11.Predict results • Given a general scenario, predict what will happen if a 
specific scenario occurs.

• Given a general scenario, predict what will happen if a 
specific course of action is taken.

12.Calculate • Given a scenario, calculate the appropriate value.

• Calculate the effective egress rate ranges for various 
ATM connection profiles.

13.Evaluate results • Given a problem-solving scenario, evaluate the results 
of a decision.

• Given a problem-solving scenario, evaluate the results 
of a course of action.

14.Justify decisions • Given a problem-solving scenario, justify a decision.

• Given a problem-solving scenario, justify a course of 
action.

Table 1:  (Continued)

Cognitive Task Example
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Exercise 2.1�
 

Place a check (�) in the appropriate boxes to indicate if the following objectives include perfor-
mance, conditions, or criteria. Write in the number of the fundamental cognitive task that best 
matches the objective’s cognitive task (see the table below or Figure 2.4) or “0” if no cognitive 
task matches. Place a check (�) in the last column to indicate whether the objective can be 
tested in a computerized testing environment.

Objectives Performance Conditions Criteria
Cognitive Task

(0-13)

Works in 
computerized 

testing 
environment

1. OS/2 Warp Clients.

2. Explain and perform the login procedure.

3. Discuss the default User object types and their 
rights. 

4. Given an out-of order list of steps for copying text 
in MS Word, put them in order within 30 seconds.

5. Fully appreciate the importance of User object 
property values.

6. Create a User object and enter user identification 
property values.

7. Describe common printer languages and the 
differences between them.     

Fundamental Cognitive Tasks

1. Specify Parameters

2. Define Terms

3. Recognize Things

4. Describe Things

5. Explain Actions and Events

6. Analyze Situation

7. Select Appropriate Actions

8. Decide What to do Next

9. Order Steps

10.Predict Results

11.Calculate

12.Evaluate Results

13.Justify Decisions
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Working with Complete but Unmeasurable Objectives
Sometimes objectives have all the necessary parts and convey clearly what to 
measure, yet specify some performance, condition(s), completion criteria, or cog-
nitive task that cannot be directly measured in the testing center. These kinds of 
objectives generally require the examinee to perform some physical task or take 
on a certain mind set or state of mind (e.g., know, understand, consider, or 
appreciate).

Examples:

• Configure an ACME-3 ATM switch for use in the specified network.

• Access the central product database.

• Understand and appreciate the need for network security

• Given the necessary hardware equipment, cables, and connectors, con-
nect the equipment to be able to create a network that works the first 
time.

Suggestions for Working with Unmeasurable Objectives
Although we cannot test physical tasks or mind sets directly, we can create exam 
items that come close. The following are some suggestions for ways to work with 
objectives that are complete, but not measurable in a computerized testing center 
environment. Many more methods are possible.

• Instead of trying to test the actual task or skill specified in the objective, 
test several critical underlying tasks, skills, or facts that are testable in a 
computerized testing environment and that are contained within, and 
integral to, the parent objective. Care must be taken to achieve the same 
level of complexity and the same level of thinking required by the origi-
nal parent objective.

• Test for the ability to predict outcomes based on the task or skill speci-
fied in the unmeasurable objective. This usually involves constructing a 
situation or scenario describing various inputs and actions taken, up to a 
specific point. The examinee is then asked what is required to complete 
tasks or predict outcomes based on the scenario.

In these cases it is sometimes helpful to think to yourself, “If a person could carry 
out this objective, could they answer the question I am about to write?”

Working with Incomplete Objectives
Some objectives do not clearly convey what to measure. They are generally miss-
ing some critical parts of the objective, like a performance, a cognitive task, con-
dition(s), or completion criteria. If you are unsure whether an objective is 
complete, ask: “How will I know if the performance is done wrong?” If you are 
unable to answer the question, the objective may not be complete.

Incomplete objectives are impossible to work with “as is.” Additional informa-
tion must be obtained, or assumptions made to fill in the missing parts before 
items can be written.

Examples:

• Configure an ACME-3 ATM switch.

• Assess a network.

• User profiles
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Suggestions for Working with Incomplete Objectives
Although it is not possible to work with incomplete objectives the way they are 
worded on the blueprint, it is generally possible to find or otherwise supply the 
missing information from the blueprint or other documents produced as part of 
the Job-Task Analysis process.

Here are some suggestions for how to find the information missing from incom-
plete objectives.

• Ask the stakeholder (the person authorizing work on the exam) for clar-
ification.

• Ask Subject Matter Experts (SMEs) who worked on writing and validat-
ing the objectives for clarification.

• Study the levels of competence specified in the Description of the MAC 
(often included in the Blueprint), then reconstruct the information you 
need as best you can. This usually works best when reconstructing miss-
ing conditions and completion criteria.

• Study the information provided in the Exam Definition or Description 
documents, then reconstruct the missing information as best you can. 
This is the method of last resort, as information in these documents is 
usually more general.

Item Performance Standards
There are several performance standards or constructs that help us determine how 
well an item measures the knowledge, task, or skill described in an objective. 
They are congruence, differentiation, and relevance. Congruence measures how 
well an item matches the objective. Differentiation refers to identifying who can 
and who cannot complete the task specified in an item at the pre-defined proper 
level of difficulty. Relevance is a measure of how applicable the item is to real 
life experience. These standards are important for achieving fairness and validity 
when using scores from an exam in certification decisions. It is fair to use scores 
from an exam when items test relevant material at the defined level of difficulty. 
It would be unfair to use scores from items that do not.

Congruence
An item is fully congruent with an objective if the item tests the knowledge, skill, 
or ability identified in the objective at the level specified by the objective. That 
is, an item is congruent when the content and complexity of the item match the 
content and complexity specified in its objective. Clearly, the more congruent the 
item is to its objective, the more valid scores from the item will be in determining 
who should be and who should not be certified. In short, the more congruent an 
item, the more fair it is to use its score. Consequently, the more congruent each 
item, the fairer it is to use the entire exam score.

Congruence is like an archery competition where items are like arrows and objec-
tives are like targets. Points are awarded based on how close arrows (items) come 
to the center of their target (the objective). Five points are awarded for a bull’s 
eye, four points for the first ring, and so forth, with no points awarded when the 
target is missed altogether. In competition, only high scoring competitors are 
allowed to continue beyond the qualifying rounds into the final competition. 
Likewise, items that do not score enough congruence points are not allowed to 
continue as part of that item bank. These items must be modified so as to become 
more congruent, be reassigned to objectives to which they are naturally more 
congruent, or be removed from the exam item bank. 

Congruence in like archery com-
petition. The closer an item comes 
to meeting all the requirements of 
the objective, the more congruent 
the item. Meeting minimum 
acceptable level of congruence 
(such as a score of 3 or better in 
archery) means the item stays.
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Congruence is composed of two distinct elements, domain (technical) congru-
ence and cognitive congruence. Here the metaphor is Olympic Ice Skating. When 
an ice skater finishes a program, judges give the skater two scores, one for tech-
nical ability, the other for artistic merit. The skater’s final score is a combination 
of these two subscores. Likewise, domain congruence and cognitive congruence 
are each evaluated on their own, then merged to determine overall congruence.

Domain (Technical) Congruence
Domain (Technical) Congruence is an estimate of how well the technical knowl-
edge or skill measured by the exam item matches the technical skill or knowl-
edge described by the objective. Items may test only a small portion of the 
domain covered by the objective, the entire objective domain, or any portion of 
the domain in between. As long as the item covers only subject matter specified 
by the objective it is highly domain congruent. Items do not need to cover all 
aspects of the objective domain to be domain congruent; they only need to cover 
some portion of it.

So, in short, the topic the item is testing must fit within the objective.

Cognitive Congruence
The second aspect of congruence is cognitive congruence. Cognitive congruence 
is an estimate of how well an exam item measures the proficiency with which the 
examinee can complete the cognitive task specified by the objective. Exam items 
should require the examinee to demonstrate the same level of thinking, mental 
skill or mental performance specified in the objective. The closer an item comes 
to directly testing the cognitive task of the objective, the more cognitively con-
gruent the item is.

Overall Congruence
The combination of both domain or technical congruence and cognitive congru-
ence yield the overall congruence rating of an item. Items that are highly domain 
congruent, but have a moderate degree of cognitive congruence are still only 
moderately congruent overall. Likewise, items with a high degree of cognitive 
congruence and a moderate level of domain congruence are still only moderately 
congruent overall. An item is only as congruent as its weakest component of con-
gruence.

In domain congruence, objectives are 
like clouds. Their boundaries define 
the edge of the subject matter in the 
objective. Items can cover a lot or a 
little of the cloud, but as long as they 
are inside, they are domain congru-
ent. Items that fall closer to the cen-
ter or core of the cloud are more 
domain congruent than those closer 
to the edge.

The way to achieve cognitive con-
gruence in an item is to make sure 
the action requested of the exam-
inee matches the verb used in the 
objective.
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Appropriate Level of Difficulty (Differentiation)
 An item should be appropriately difficult for and written to the MAC. It should 
be a “three-foot’ item—not a one foot or a five foot item—a three foot item on 
our three foot exam. If an item is highly congruent, it will likely already differen-
tiate appropriately. However, it is more than possible to create relatively congru-
ent items that do not differentiate at the proper level, and so, item writers and 
reviewers must be vigilant to make sure all items differentiate at the proper level.

It is often tempting to believe that harder items make a better exam. Nothing 
could be further from the truth. 

Relevance
In addition to congruence and differentiation, an exam item should also be rele-
vant. A relevant item covers relevant and important content that applies directly 
to the objective, the domain, and the end certification. The item should be crucial 
enough that should the examinee miss the item, you would question whether the 
examinee should be awarded certification.

There are some questions we can ask ourselves about items we are evaluating for 
the property of relevance. Some of these questions are:

• Does it really matter if the examinee can answer this question 
(item)? 

• If an examinee can answer this question (item) will I be more 
inclined to certify them? 

• If an examinee can’t answer this question (item) would I still certify 
them? 

Conclusion
Congruent, relevant exam items that differentiate at an appropriate level of diffi-
culty will:

• Produce scores valid for use in making certification decisions

• Produce scores that are reliable

• Differentiate between a candidate who knows and can do and a candi-
date who doesn’t know and can’t do.

• Not surprise a candidate who has read the certification requirements and 
knows the material specified in the objectives.

.

Items should be written to an 
appropriate level of difficulty. We 
should only allow three-foot items 
on our three-foot exam. One-foot 
and five-foot items should not be 
included because they are not fair 
and do not tell us what we need to 
know.
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Exercise 2.2

Estimate the level of congruence, difficulty, and relevance each exam item demonstrates by writing a 
number in the appropriate cell.
                          
Objective 2.2:   In Microsoft Word, delete a table or delete items from a table.

Exam Item Technical 
Congruence

(0-5)

Cognitive 
Congruence

(0-5)

Appropri-
ate Diffi-

culty
(1-5 feet)

Relevance

(Y/N)

Item 1:

How do you delete a table and its contents? (Choose 
three.)

A. select the table, press the Backspace key.
B. select the table, click Cut on the tool bar or 

Edit menu.
C. select the table, press the Delete key.
D. select the table, press the Return key.
E. select all columns, under the Table menu 

select Delete Columns.
F. select all rows, under the Table menu select 

Delete Rows.
                          

Item 2:

Which two tasks can be done using the Edit menu? 
(Choose two.)

A. changing the color of text
B. finding and replacing text
C. deleting a table and all of its contents
D. inserting a Page Break into a document
E. running a spelling check on a document

                          

Item 3:

Using Microsoft Word, delete Table 3, titled Frogs of 
South America, from the open document Science 
Project.          
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Exercise 2.3
Estimate the level of congruence, difficulty, and relevance item 2.3 demonstrates with each 
objective by writing a number in the appropriate cell.
        
Exam Item 2.3: 

You are assembling your SCUBA unit on shore prior to boarding the dive boat. You have just taken the 
dust cap off the regulator yoke, placed the yoke over the tank valve, and tightened the yoke finger tight. 
According to the SSI standard assembly procedure, what should you do next?

A. Check the pressure gauge to make sure the tank is filled.
B. Attach the power inflator hose to the buoyancy compensator.
C. Put the second stage in your mouth, exhale through it, and gently attempt to inhale.
D. Hold the pressure gauge face down away from you and others and slowly open the tank valve 

all the way. 

Exam Objectives Technical 
Congruence

(0-5)

Cognitive 
Congruence

(0-5)

Appropriate 
Difficulty
(1-5 feet)

Rele-
vance

(Y/N)

1. Identify the steps in the SSI standard assembly proce-
dure. 

2. Define the term “SCUBA unit.”

3. Describe the process of assembling the SCUBA unit.

4. Given a SCUBA assembly situation, tell what to do 
next in order to put together the SCUBA unit cor-
rectly.

5. Describe the interrelationships between the parts of 
the SCUBA unit.

6. Tell how the parts of the SCUBA unit work together.

7. Differentiate between the power inflator hose and the 
second stage.

8. Given a description of a SCUBA assembly, predict 
how that assembly is likely to function.
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Exercise 2.4
�

Write an objective that matches item 2.4.
                          
Objective:
                          
                          
                         

 
                          
                          
Item 2.4:

What is one way to select all the text and graphics in a Microsoft Word document?

A. Alt-A
B. Ctrl-A
C. Shift-A
D. Shift-Enter
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Chapter 3

The Exam Item Writing Process

Steps to Successful, Focused Item Development
Good item developers will tell you that item development is often more of an art 
than a science. In truth, good item writing consists of some “science,” some “art” 
and a lot of just plain work! There is no special formula that can be developed and 
programmed into a computer to produce good exam items. Item writing is a very 
“human oriented” function and may seem subjective at times. Our goal in this chap-
ter is to train the prospective item writer to write items that will be congruent to 
exam objective(s). Well developed items will greatly enhance the probability that 
the exam will have high validity and reliability. Let’s look at one psychometrically 
sound procedure for developing good exam items. 

In this procedure item development (or item writing) can be distilled into eight key 
steps:

1. Interpret the objective

2. Plan the item

3. Produce the item

4. Verify item functionality

5. Document the item

6. Re-evaluate and revise the item

7. Elicit peer feedback and revise the item

8. Submit the item for formal review
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Exercise 3.1
Write an item for the objective: “Identify small electric kitchen appliances by sight.”

Produce the Item 
(You can use the worksheet on the 
next page to help with the first 
three steps of the process.)
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Objective: Identify small electric kitchen appliances by sight.

Step 1: Interpret the objective

Find the center or core of the 
objective (the Cognitive Task):

Establish proper level of difficulty

Step 2: Plan the item

Select a cognitive strategy

1.Specify parameters
2.Define terms
3.Recognize things
4.Describe things
5.Explain actions and events
6.Analyze situations
7.Select appropriate actions
8.Decide what to do next
9.Order steps
10.Predict results
11.Calculate
12.Evaluate results
13.Justify decisions

Select the response mode (exam 
item type):

Stem (first draft):

Distractors,
exhibits,
materials:

Key:

Scoring:

Step 3: Produce the Item

First draft (put the pieces together):
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Chapter 4

Item Writing Rules
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Item Writing Checklist
Clear communication is one of our highest priorities when writing test items. Items that are direct, concise, and 
easily understood provide scores that are more reliable than items that meander, obfuscate, and confuse. The 
following is a list of rules for writing effective test items. These rules have been proven to help in constructing 
understandable items that discriminate between qualified and unqualified candidates. 
Below is a list of the rules. The remainder of “Chapter 4: Item Writing Rules” provides you with additional 
explanations and examples of how the rules apply to writing test items.

1. Match the item to the objective . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
2. Create answer options that are clear, distinct, and plausible . . . . . . . . . . . 25
3. Include all information needed to respond to the item . . . . . . . . . . . . . . . 25
4. Keep items independent. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
5. Verify items technically . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
6. Write appropriately difficult (three-foot) items  . . . . . . . . . . . . . . . . . . . . . 25
7. Make items relevant . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 25
8. Test specified knowledge, not test-taking skills . . . . . . . . . . . . . . . . . . . . . 25
9. Don’t give clues to the correct answer within the item . . . . . . . . . . . . . . . 25
10. The guessing factor should be p=0.25 or less . . . . . . . . . . . . . . . . . . . . . . 25
11. Focus on one thought, problem, or idea . . . . . . . . . . . . . . . . . . . . . . . . . . 26
12. Include the criteria when items call for a judgment . . . . . . . . . . . . . . . . . . 26
13. Avoid words that are overly complex or have multiple meanings. . . . . . . . 26
14. Avoid using “NOT” in the stem  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
15. Avoid absolute and imprecise modifiers  . . . . . . . . . . . . . . . . . . . . . . . . . . 26
16. Keep stems complete and options specific  . . . . . . . . . . . . . . . . . . . . . . . . 26
17. Separate enemy items  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
18. Separate item variants  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 26
19. Use item isomorphs  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
20. Convey stem intent precisely and effectively . . . . . . . . . . . . . . . . . . . . . . . 27
21. Eliminate localization and sensitivity issues . . . . . . . . . . . . . . . . . . . . . . . . 27
22. Obey the rules of grammar and usage  . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
23. Format items for readability. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
24. Use graphics effectively  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
25. Use text exhibits effectively. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 27
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Item Writing Rules

1. Match the item to the objective
Make certain that the item closely relates to the objective it is intended to 
measure (congruence).

2. Create answer options that are clear, distinct, and plausible
Nothing should get in the way of an examinee selecting a correct answer. That 
means answer options must offer clear-cut, distinct, unambiguous choices for 
examinees to evaluate. In addition, all distractors should look, feel, and sound 
like they could be the correct answer.

Don’t use combination-style Multiple-Choice answer options (i.e., A and B). 
They often provide unintended clues about the correct answer and reduce the 
number of plausible distractors for the item.

3. Include all information needed to respond to the item
Any information or exhibits that the candidate would need to correctly respond to 
the item should be included in the item.

4. Keep items independent
Do not refer to any part of any other item. Because each item may appear in a 
different order each time a test is administered, each item must be complete and 
stand by itself.

5. Verify items technically
Items must be verified as correct and should be correct as long as the test is 
available to candidates.

6. Write appropriately difficult (three-foot) items
Items that are too easy or too hard do not differentiate between those who have 
the knowledge, skills, and abilities the test addresses and those who do not. 

7. Make items relevant
Items must be relevant if they are to help distinguish between those who will pass 
and those who will not.

8. Test specified knowledge, not test-taking skills
Don’t trick the examinee. Hiding meaning in complex or over-precise wording 
makes reading comprehension more of a determinant in whether candidates 
answer correctly than whether they know the content.

9. Don’t give clues to the correct answer within the item
It is possible to inadvertently give clues to the correct response within the item 
itself. These come in many forms. One way is using the same or closely related 
key words in the stem and only one of the answer options.

10. The guessing factor should be p=0.25 or less
The Information Technology industry has adopted a minimum standard of a 
p=0.25 probability of guessing correctly. What this means is:
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• items should have four or more answer options, but no more than eight. 
Eight is a limitation of some test delivery drivers. In addition, large 
numbers of options are often confusing.

• the probability of guessing correctly can be calculated for complex 
items. However, if the number of options are four or more, the guessing 
probability is less than p=0.25.

• the probability of guessing correctly on a four option multiple-choice 
item is:

•1 correct of 4=0.25

•2 correct of 4=0.167

•3 correct of 4=0.25

• each item should have at least one correct and one incorrect option.

11. Focus on one thought, problem, or idea
Often an objective will cover a complex concept or range of concepts that should 
be broken down into single, simple concepts for the purpose of creating items. 
When possible, limit items to a single thought per item.

12. Include the criteria when items call for a judgment
When asking examinees to choose between multiple correct options, you must 
specify the criteria by which they are to choose. 

13. Avoid words that are overly complex or have multiple 
meanings 
Multiple uses of words with more than one meaning can confuse candidates and 
cause otherwise qualified candidates to miss the item. Write to a 6th-grade 
reading level.

14. Avoid using “NOT” in the stem
Write the stem in a positive form. The use of “NOT” is NOT encouraged. It is 
often overlooked by candidates and can confuse them, especially when English is 
not their first language. It leads otherwise qualified candidates to select a an 
incorrect answer. It is better to ask, “Which three are correct?” than to ask, 
“Which one is NOT correct?”

15. Avoid absolute and imprecise modifiers
Absolute (“always,” “never”) and imprecise (“best,” “recommended”) words can 
confuse candidates and/or give away answers. 

16. Keep stems complete and options specific
The examinee should be able to read the stem and know what the correct answer 
is before viewing the options.

17. Separate enemy items
When an item gives away or cues the answer to another item, the items are called 
enemy items. Both items may be OK to use on the test, but they should never be 
placed on the same test form.

18. Separate item variants
Two or more items are called item variants when they address the same content. 
Variants are usually the same item asking for the same response in a slightly 
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different response mode.

19. Use item isomorphs
Isomorphs are items that are nearly identical but are different in some important 
way. Differences between isomorphs usually result in different correct responses. 
A well thought out, complex scenario-based item is an excellent candidate for 
creating isomorphs by changing one or two details in the stem, scenario, 
instructions, or prompts which result in a different correct answer.

20. Convey stem intent precisely and effectively
Item stems are the stimuli and prompts that elicit responses from examines. 
Stems need to convey clearly, completely and precisely how you want the 
examinee to indicate a correct response. In multiple-answer, multiple-choice 
items, it is important to let the candidate know the number of responses. 
Whenever possible, double-cue within the stem.

21. Eliminate localization and sensitivity issues
Exam items should not offend candidates nor give an advantage or disadvantage 
to any gender, ethnic, or cultural group. Items should be neutral, designed so that 
qualified examinees will be able to select correct answers, no matter what ethnic 
or geographic background they come from.

22. Obey the rules of grammar and usage
Rules of grammar, punctuation, and spelling are established standards that 
examinees expect. Deviations from a standard confuse the examinees and may 
lead them to believe they are being tricked. 

23. Format items for readability.
The way an item is laid out on the screen has a significant effect on how quickly 
and easily examinees can find and decode the various elements of the item. 
Choice of font type, point size, style, placement of text, buttons and so forth all 
contribute to the way an item is perceived by examinees.

24. Use graphics effectively
Graphics may be used with items in several different ways. They may be 
included as standard exhibits accessible via the Exhibit Button, exhibits activated 
by other on-screen buttons, placed directly (embedded) in the stem rich text 
(RTF) field, embedded in multiple choice option RTF fields, or be included as 
part of a Drag and Drop, Point and Click, or Complex Graphic (GGI) item. No 
matter where a graphic is used, it must have certain simple, but important 
attributes in order to work with test delivery drivers.

25. Use text exhibits effectively
Text exhibits are displays of interpretive material too long or detailed to be 
included directly as part of the stem. A text exhibit is usually an attached text file 
in Microsoft Rich Text file format, containing narrative, tables, listings, program 
output, or some other text-based presentation. These exhibits are accessed by 
clicking an on-screen button located either on the bar at the bottom of the test 
delivery driver window or along the top to the item window. When clicked, a 
window containing the exhibit is displayed within the main window containing 
the test item
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Exercise 4.1

Which test item is clearest?

Item 1: 

Which three technological innovations had the greatest impact on the size and power of modern com-
puters?  (Choose three.)

A. transistors
B. integrated circuits
C. tubes and switches
D. printed circuit boards

Item 2: 

Which invention(s) had a large impact on modern computers?

A. transistors
B. integrated circuits
C. tubes and switches
D. printed circuit boards

Which rules apply to this exercise?
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Exercise 4.2

Items 1 and 2 appear on the same test, as do items 3 and 4. Which pair of items (1 and 2 or 
3 and 4) best demonstrates the principle of item independence?

Item 1: 

In Microsoft Excel, which tool is used to manipulate existing worksheet data into a more understandable 
viewing format?

A. Pivot table
B. Merge and Center
C. Format Painter
D. Print Preview
E. Solver

Item 2: 

Into which three formats can a Microsoft Excel spreadsheet be exported? (Choose three.)

A. wpg
B. dat
C. wk1
D. xls
E. dbf

Item 3: 

A data analyst is using Microsoft Excel to analyze marketing research data. Two worksheets are open, 
but each time the analyst tries to access the 2nd worksheet by clicking on the tab at the bottom, an error 
occurs and the computer stops responding. 

Which keystroke command will bring up the 2nd worksheet?

A. <F12>
B. <CTRL – T>
C. <ALT – TAB>
D. <SHIFT – F10>

Item 4: 

Given the scenario in the previous question, whom should the analyst contact to report the software 
problem?

A. any Microsoft retail store
B. Microsoft University Hotline
C. Microsoft Customer Support
D. the person or company from whom Excel was purchased
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Which rules apply to this exercise?

Exercise 4.3

Which test item attempts to trick the examinee?

Item 1: 

Which four are valid classes of service for ATM? (Choose four.)

A. ABR
B. CBR
C. NBR
D. UBR
E. VBR
F. XBR

Item 2: 

Which five are valid classes of service for ATM? (Choose five.)

A. ABR
B. CBR
C. nrt–VBR
D. rt–VBR
E. UBR
F. VBR–nrt
G. VBR–rt
H. XBR

Which rules apply to this exercise?
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Exercise 4.4
Which test item is more effective and why?

Item 1: 

You need to connect an office with five lightly used workstations to your 10 Mbs LAN. Which device 
would best link them to the LAN?

A. Hub
B. Bridge
C. Router
D. Switch

Item 2: 

You need to connect an office with five lightly used workstations to your 10 Mbs LAN. Which device 
would most inexpensively link them to the LAN?

A. Hub
B. Bridge
C. Router
D. Switch

Which rules apply to this exercise?

Exercise 4.5

Which test item is more effective?

Item 1:

Which three bones are located in the middle ear? (Choose three.)

A. anvil
B. stirrup
C. concha
D. hammer

Item 2:

Which bone is not located in the middle ear? 

A. anvil
B. stirrup
C. concha
D. hammer
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Which rules apply to this exercise?

Exercise 4.6
Which test item is more effective and why?

Item 1:

Which written instrument is used to convey an interest in real property?

A. lien
B. deed

Item 2:

Which written instrument is used to convey an interest in real property?

A. title
B. lien
C. note
D. deed
E. escrow

         

Which rules apply to this exercise?
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Exercise 4.7
Which items are isomorphs and which items are variants of item 1?

Item 1:

You must design a converged network for a company. Fifteen workstations exist in a building with a 
complex telephone system. Two mainframes are in remote geographic areas. 

Which topology should you choose, considering relative cost and versatility? 

A. bus
B. ring
C. mesh
D. hybrid

Item 2:

You must design a converged network for a company. Fifteen workstations exist in a building with a 
complex telephone system. Two mainframes are in the same building. 

Which topology should you choose, considering relative cost and versatility? 

A. bus
B. ring
C. mesh
D. hybrid

Item 3:

You must design a converged network for a company. Fifteen workstations exist in a building with a 
complex telephone system. Two mainframes are in remote geographic areas. 

Which topology should you choose if cost is not an issue? 

A. bus
B. ring
C. mesh
D. hybrid

Item 4:

You have been asked to build a converged network for your company’s customer support center. Eigh-
teen workstations currently exist in an office building with a complex telephone system. Two mainframes 
are located off-site in geographically remote areas.

Which network topology should you choose if cost and versatility are paramount concerns?

A. bus
B. star
C. ring
D. mesh
E. hybrid
F. multidrop
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Exercise 4.8

Looking at the two stems, which is more effective and why?

Item 1: 

Object permanence means _____.

A. understanding that objects that are permanent can be used as landmarks.
B. understanding that objects exist even if they cannot be seen, heard or otherwise perceived.
C. learning the difference in clues and landmarks and how they can be used during independent 

travel.
D. learning about the environment through structured learning experiences

Item 2: 

With respect to someone who has always been blind, what does object permanence mean?

A. Understanding that objects that are permanent can be used as landmarks.
B. Understanding that objects exist even if they cannot be seen, heard or otherwise perceived.
C. Learning the difference in clues and landmarks and how they can be used during independent 

travel.
D. Learning about the environment through structured learning experiences

Which rules apply to this exercise?
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Exercise 4.9

Which item is free of localization problems?

Item 1: 

Which statement describes a loan that should be classified as a loss?

A. The obligor is incurring substantial deficits in the operation of other business ventures.
B. Management is of the opinion that the obligor may be dishonest, however collateral values 

appear adequate.
C. The loan is severely past due, collateral has ample value, but management is unable to locate 

the collateral of the obligor.
D. The statutory period in which legal action can be taken against the obligor has expired, although 

the bank can sell the loan.
E. The loan is past due more than six months and tangible collateral is inadequate, but the guaran-

tor has supported the loan in the past.

Item 2: 

Which financial agency is responsible for monitoring banking regulations in the United States?

A. FDIC
B. OCC
C. NASD
D. NUCUA

Which rules apply to this exercise?
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Exercise 4.10

Which item is more effective?

Item 1: 

How does one utilize a vacillating pendulum in an inverted, metallic, resonant cup?

A. palpate the inverted, metallic, resonant cup with a sheet of webbed fabric
B. retain the inverted, metallic, resonant cup in the vertebrate grasping appendage and rotate the 

radius bone briskly
C. pitch the inverted, metallic, resonant cup into solidified, granulated oxygenated hydrogen.
D. position directly and accurately the metallic resonant cup onto an elevated wooden plane.

Item 2: 

How do you ring a bell?

A. touch the bell with a cloth
B. shake the bell with your hand
C. drop the bell in the snow
D. set the bell on a table

Which rules apply to this exercise?
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Exercise 4.11

Of the two stems shown, which is more effective and why?

Item 1

Which of the following is required in order to connect to a 10 Mbs LAN network?

Item 2

What is required to connect to a 10 Mbs LAN? 

Which rules apply to this exercise?
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Chapter 5

BenchMark 4.0 Exercises

Exercise 1: Creating a Multiple-Choice Item
Multiple-choice is the most common item type. It is a question followed by four or 
more options. The steps in this section demonstrate how to create an item like the 
one shown below. To create your own item, simply substitute your content for the 
content that we specify in the directions.

To navigate the TreeView window

1 Click the Cabinet pull-down menu, then select Example.
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The Example cabinet opens. In it is a bank folder  named (EX1)Example 
Bank.

2 Click the plus sign (+) next to the (EX1) Example bank to expand its con-
tents, then click the (+) to expand the (EX1.1) Multiple-Choice Items 
section.

Cabinet pull-down menu

Click the minus sign (-)
to close the folder

Click the plus sign (+)
to expand the tree view
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To create the multiple-choice item

1 Right-click the objective (EX1.1.1) Create a single-response Multiple-
Choice item and then click New Item on the menu. 

The Select Item Type dialog box opens.

2 Click the Item Type menu, select Multiple-Choice, then click OK.

The Multiple-Choice item workspace window opens. In the workspace is a 
box in which you write the stem for the item.
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3 Type the stem as shown below.

4 Right-click anywhere on the item screen and choose Add Option from the 
menu. (You can also press Ctrl+O to add an option.) 

BenchMark inserts an empty check box, the letter “A” and a box for the 
option text.

5 Type Eagle. 

6 Create three more options as you did in step 4, then type Chicken, Pelican, 
and Swallow in their respective text boxes.

7 Click the Sort by Length  on the toolbar to arrange the options from 
shortest to longest.

Type the stem text
in the box

Type the option
text in the box
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8 Indicate the correct answer by clicking the check box next to option A 
(Eagle).

9 Click Save Changes .

To add a reference

1 In the Property Inspector for the item click the References field > the 

settings  button. 

The Item References dialog box opens.

2 Click Add.

The Add Item Reference dialog box opens.

3 Select Encyclopedia International, Volume 3.

4 Type Page 212 in the text field.

A check in the check box
indicates that the option is a

correct answer. You can
select more than one option

to be correct
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5 Click Finish.

6 Click OK.

7 In the Property Inspector, click the Audits tab. 

A list of audits appears. The first check box, Item Written, is empty, indicat-
ing that it is the current status of the item.

8 To indicate that the Item Written stage is complete, click the box next to 
Item Written. 

An “X” appears, indicating that that step is complete.
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Exercise 2: Adding an Exhibit to a Multiple-Choice Item
Occasionally you will need to add an exhibit, either a graphic or text, to help the 
candidate understand the question and options in the multiple choice item. This 
section explains how to create a multiple choice item that includes an exhibit, as 
shown below. 

To navigate the Tree View window

1 Click the Cabinet pull-down menu, then select Example.

The Example cabinet opens. In it is a bank folder  named (EX1)Example 
Bank.

Cabinet pull-down menu
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2 Click the plus sign (+) next to the (EX1) Example bank to expand its con-
tents, then click the (+) to expand the (EX1.1) Multiple-Choice Items 
section.

To create the multiple-choice item

1 Right-click the objective (EX1.1.2) Create a single-response Multiple-
Choice item with a resource and then click New Item on the menu. 

Click the minus sign (-)
to close the folder

Click the plus sign (+)
to expand the tree view
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The Select Item Type dialog box opens.

2 Click the Item Type menu, select Multiple-Choice, then click OK.

The Multiple-Choice item workspace window opens. In the workspace is a 
box in which you write the stem for the item.

3 Type the stem as shown below.

4 Right-click anywhere on the item screen and choose Add Option from the 
menu. (You can also press Ctrl+O to add an option.) 

BenchMark inserts an empty check box, the letter “A” and a box for the 
option text.

Type the stem text
in the box
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5 Type Eagle. 

6 Create three more options as you did in step 4, then type Chicken, Pelican, 
and Swallow in their respective text boxes.

7 Click the Sort by Length  on the toolbar to arrange the options from 
shortest to longest.

8 Indicate the correct answer by clicking the check box next to option A 
(Eagle).

9 Click Save Changes .

Type the option
text in the box

A check in the check box
indicates that the option is a

correct answer. You can
select more than one option

to be correct
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Adding an Exhibit

1 In the item edit window, click File > New Resource. 

The Resource dialog box opens.

2 Click the eaglebmp file. 
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A thumbnail of the graphic opens in the preview window.

3 Click OK.

The image is attached to the item.

To preview the item

1 In the Item Edit window, click Preview .

A preview version of the item opens.

2 Click the Exhibit button to see the graphic. 

The eagle graphic opens.
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To verify the scoring

1 Click option A, Eagle, the correct answer, then right-click anywhere on the 
item and click Score (or press Ctrl-S). 

The score box indicates that your answer was correct.

2 Close the Preview version of the item by clicking Close  in the upper-
right corner of the item window.
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Exercise 3: Creating a Drag & Drop Item Using a GGI 
Template

Drag & drop items add interactivity to an item and allow for matching and 
sequencing. This section shows the benefits of having a GGI template for quickly 
creating drag & drop items. These steps demonstrate how to create an item like 
the one shown below. To create your own item, simply substitute your content for 
the content that we specify in the directions.

To navigate the TreeView

1 Click the Cabinet pull-down menu, then select Example.

Cabinet pull-down menu
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2 Click the plus (+) next to the (EX1) Example bank to expand its contents, 
then click the plus (+) to expand the (EX1.4) Drag & Drop Items section.

3 Select the objective (EX1.4.1) Create a Drag & Drop item.

To create an item

1 Right-click the objective and click New Item on the menu. 

The Select Item Type dialog box opens.

2 Click the Item Type menu > Galton Graphical > OK.

Click the minus sign (-)
to close the folder

Click the plus sign (+)
to expand the tree view
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The Galton Graphical item window opens. In the item window is a text box 
in which you write the stem for the item.

3 Type the text as shown in the following illustration.

4 Click Save .

To add a Drag & Drop task

1 In the item edit window, click File > New Resource. 

Type the stem text
in the box
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The Resources dialog box opens.

2 Click New. 

The Select Resource Type dialog box opens.

3 Click Galton Graphical > OK.

The BenchMark GGI Development Tool opens. These windows are used to 
create the Drag & Drop item. 
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To load a template

1 Click Open .

2 Browse to the shared folder on the network that contains the Order Steps.ggi 
file.

3 Click the Order Steps.ggi file, then click OK. 

A nearly complete drag & drop project opens. All of the objects have been 
created and positioned already. You only need to change the caption text of 
the panels.

The Component
toolbar lets you add
objects such as text,
shapes, and panels.

The Object
Inspector lets you
view and change

settings for the
GGI project and

any components of
the project.

The Canvas is where you
lay out the GGI project,
including text, buttons,

panels, images, etc.
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4 Add text to a source panel or label by selecting it, then typing the text string 
in the Caption field of the Object Inspector. 

The graphic below shows where to put each text string.

5 To add a caption to the GGI window, click an empty area of the canvas, then 
type the text in the Caption field.

To change the aliases of the panels

To help in scoring, the Alias parameter for each panel needs to be named. 

1 Select a panel, then in the Object Inspector, type the alias names in the Alias 
field as indicated in the following illustration.

To Close the GGI Tool and return to the item

1 Click OK  to save the image and close the GGI Tool.

The Resource Name dialog box opens. 

2 Type a name for the resource. 

Resource names must follow the 8.3 naming convention. A rule of thumb is 
to use the Item ID in the name. For example, type BM131 if the item ID is 
BM.1.3.1.

The GGI project opens on top of the original item screen.

3 Drag the source panels to the correct destination panels. 

Listen

Enter

Pick

Second

First

Third
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4 Click Done.

A Confirm dialog box opens.

5 Click Yes to accept the results as the correct answer for the item.

This adds an option containing the text string to your item just below the 
stem. Don’t worry about interpreting or understanding the text string.

To preview the item

1 Click Preview . 

A preview version of the item opens. 

2 Click the Task button.

3 When the GGI project opens, drag the source panels to the correct destina-
tions, then click Done.

The GGI project closes

Verify the Scoring

1 Right-click anywhere in the item and click Score. 

The score box should indicate that your answer was correct. To ensure incor-
rect responses are scored correctly, place the source panels on incorrect des-
tination panels.

2 Click OK to close the score box.

3 Click End Preview  to exit preview mode.

To finish up

1 In the Property Inspector, click References > settings . 

2 Click Add.

3 Select Chapter 1: How to make a telephone call: Telemarketing 101.

4 Type page 17 in the text box.

5 Click Finish.

6 Click OK.

7 Click the Audits tab. 

A list of audits appears. The first check box, Item Written, is empty, indicat-
ing that it is the current status of the item.

8 To indicate that the Item Written stage is complete, click the box next to 
Item Written. 

An “X” appears, indicating that that step is complete.
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Exercise 4: Creating a Point & Click Item
Point & click items add interactivity to an item where the candidate is required to 
identify one or more objects. These steps demonstrate how to create an item like 
the one shown below. To create your own item, simply substitute your content for 
the content that we specify in the directions.

It will look like this:

To navigate the TreeView

1 Click the Cabinet pull-down menu, then select Example.

2 Click the plus sign (+) next to the (EX1) Example bank to expand its con-
tents, then click the (+) next to (EX1.3) Point & Click Items to expand the 
section.

Cabinet pull-down menu
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3 Select the objective (EX1.3.1) Create a Point & Click item.

To create the item

1 Right-click the objective and click New Item on the menu. 

The Select Item Type dialog box opens.

2 Click the Item Type menu, click Galton Graphical, then click OK.

Click the minus sign (-)
to close the folder

Click the plus sign (+)
to expand the tree view
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The Galton Graphical item workspace window opens. In the item window is 
a text box in which you write the stem for the item.

3 Enter the text as shown in the following illustration.

To add a Point & Click task

1 Right-click anywhere on the Item Edit screen, then select New Resource. 

Type the stem text
in the box
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The Resources dialog box opens.

2 Click New. 

The Select Resource Type dialog box opens.

3 Click Galton Graphical > OK.

The BenchMark GGI Development Tool opens. These windows are used to 
create the Point & Click item. 



CHAPTER 5: BENCHMARK 4.0 EXERCISES
Exercise 4: Creating a Point & Click Item

63

4 On the Components toolbar, click the Hot Image  button, then click 
anywhere on the canvas. 

The Galton Imaging Tools program opens.

5 Click Open Image  on the toolbar.

The Open File dialog box opens.

6 Browse to the Resources shared folder then click birdman.bmp. 

7 Click Open. 

The Component
toolbar lets you add
objects such as text,
shapes, and panels.

The Object
Inspector lets you
view and change

settings for the
GGI project and

any components of
the project.

The Canvas is where you
lay out the GGI project,
including text, buttons,

panels, images, etc.
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The image opens in the GI Tool.

8 Click Save Changes and Return to BenchMark  to save the image 
and exit the GI Tool. 

The HotSpots dialog box opens.

9 Click New to add a hot spot area to the picture. 

The HotSpot Editor opens.

10 Click Edit Shape and move the cursor over the picture. The cursor will 
change to a crosshair. 
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11 To create the hot spot, click somewhere near the outline of the bird that is on 
top of the man’s head. Then move the cursor around the outline of the bird, 
clicking at any necessary change of direction. 

12 To complete the hot spot, right-click when near the first point of the hot spot 
area. 

This completes the area and places the coordinates in the Points box.

13 Make sure Enabled is checked.

14 Click Hint Text box, then delete the number and type Bird on hat.

15 Click OK. 
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The HotSpot Editor closes. The hotspot you created is displayed in the 
HotSpots dialog box. 

To create other hot spot areas, repeat steps 9–14 until you have added all the 
hot spots you need. You might want to define hot spots for the most plausible 
distractor areas as well as for any other correct responses.

16 Click OK. 

The HotSpots dialog box closes. The Hot Graphic appears on the canvas.

17 Click the Hot Graphic and drag it to the center of the Canvas. 

18 Use the handles around the image to stretch the frame surrounding the image 
to the proper size.

To add a done button to the Point & Click item

1 From the Components toolbar, click the Button  tool, then click any-
where on the GGI canvas. 

This adds a button to the canvas. The Object Inspector displays the settings 
for the button.

2 Drag the button to the bottom-left corner of the canvas.
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To Close the GGI Tool and return to the item

1 Click OK  to save the image and close the GGI Tool.

The Resource Name dialog box opens. 

2 Type a name for the resource. 

Resource names must follow the 8.3 naming convention. A rule of thumb is 
to use the Item ID in the name. For example, type BM131 if the item ID is 
BM.1.3.1.

The GGI project opens on top of the original item screen.

3 Click the bird on the man’s head.

When the pointer is over the correct area, the “Bird on hat” hint should 
appear.

4 Click Done.

A Confirm dialog box opens.

5 Click Yes to accept the results as the correct answer for the item.

This adds an option containing the text string to your item just below the 
stem. Don't worry about interpreting or understanding the text string.

To preview the item

1 Click Preview . 

A preview version of the item opens. 

2 Click the Task button.

3 When the GGI project opens, click the correct area of the image.

Verify the Scoring

1 Right-click anywhere in the item and click Score. 

The score box should indicate that your answer was correct. 

2 Click OK to close the score box.

To ensure incorrect responses are scored correctly, click outside the correct 
area.

3 Click End Preview  to exit preview mode.

To finish up

1 In the Property Inspector, click References > settings . 

2 Click Add.

3 Select Chapter 1: Relationships of Objects.

4 Type page 4 in the text box.

5 Click Finish

6 Click the Audits tab. 



DEVELOPING CERTIFICATION TEST ITEMS
Item Developer’s Guide

68

A list of audits appears. The first check box, Item Written, is empty, indicat-
ing that it is the current status of the item.

7 To indicate that the Item Written stage is complete, click the box next to 
Item Written. 

A check mark appears, indicating that that step is complete.
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Exercise 5: Creating a Brief Free Response Item
Brief response items require the candidate draw the correct answer from memory. 
These steps demonstrate how to create an item like the one shown below. To cre-
ate your own item, simply substitute your content for the content that we specify 
in the directions.

To navigate the TreeView

1 Click the Cabinet pull-down menu, then select Example.

 

2 Click the plus sign (+) next to the (EX1) Example bank to expand its con-
tents, then expand the (EX1.2) Brief Response Items section.

Cabinet pull-down menu
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3 Select the objective (EX1.2.1) Create a Brief Response item.

To create the item

1 Right-click the objective and click New Item on the menu. 

The Select Item Type dialog box opens.

2 Click the Item Type menu > Free Response > OK.

The Free Response item workspace window opens. In the item window is a 
text box in which you write the stem for the item.

3 Enter the text as shown in the following illustration.

Click the minus sign (-)
to contract the tree view

Click the plus sign (+)
to expand the tree view

Type the stem text
in the box
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To enter the correct answer

1 Right-click anywhere on the item screen and choose Add Option from the 
menu. (You can also press Ctrl-O to add an option.) 

You should see the letter “A” and a box for you to type the option.

2 Type the correct answer. In this exercise, the correct answer is since.

3 In the Property Inspector, make sure that IgnoreCase is selected. 

This ensures that both Since and since are correct answers.

4 Click Save .

“Sinse” is intentionally
misspelled.



DEVELOPING CERTIFICATION TEST ITEMS
Item Developer’s Guide

72

To preview the item

1 Click Preview  on the tool bar. 

A preview version of the item opens. The option is replaced by a box where 
the candidate can type the answer.

To verify the scoring

1 In the answer box, type since. 

2 Right-click anywhere on the item and choose Score from the menu. 

The score box indicates that your answer was correct. 

3 Click OK to close the score box.

You can check to see if incorrect answers are scored correctly type in an 
incorrect answer.

4 Click End Preview  to close the preview mode.

To finishing up

1 In the Property Inspector, click References > settings . 

2 Click Add.

3 Select 100 Commonly Misspelled Words.

4 Type page 37 in the text box.

5 Click Finish

6 Click the Audits tab. 

A list of audits appears. The first check box, Item Written, is empty, indicat-
ing that it is the current status of the item.

7 To indicate that the Item Written stage is complete, click the box next to 
Item Written. 

A check mark appears, indicating that that step is complete.
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Exercise 6: Creating a Drag & Drop Item
Drag & drop items add interactivity to an item and allow for matching and 
sequencing. These steps demonstrate how to create a drag & drop item like the 
one shown below from scratch. To create your own item, simply substitute your 
content for the content that we specify in the directions.

To navigate the Tree View

1 Click the Cabinet pull-down menu, then select Example.

2 Click the plus (+) next to the (EX1) Example bank to expand its contents, 
then click the (+) next to (EX1.4) Drag & Drop Items to expand the 
section.

Cabinet pull-down menu
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3 Select the objective (EX1.4.1) Create a Drag & Drop item.

To create an item

1 Right-click the objective and click New Item on the menu. 

The Select Item Type dialog box opens.

2 Click the Item Type menu > Galton Graphical > OK.

Click the minus sign (-)
to contract the tree view

Click the plus sign (+)
to expand the tree view
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The Galton Graphical item window opens. In the item window is a dashed 
box in which you write the stem for the item.

3 Type the text as shown in the following illustration.

4 Click Save .

To add a Drag & Drop task

1 In the item edit window, click File > New Resource. 

Type the stem text
in the box
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The Resources dialog box opens.

2 Click New. 

The Select Resource Type dialog box opens.

3 Click Galton Graphical > OK.

The BenchMark GGI Development Tool opens. These windows are used to 
create the Drag & Drop item. 
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To make source panels

1 On the Components toolbar, click the Source Panel  button, then click 
anywhere on the GGI canvas. 

The Component
toolbar lets you add
objects such as text,
shapes, and panels.

The Object
Inspector lets you
view and change

settings for the
GGI project and

any components of
the project.

The Canvas is where you
lay out the GGI project,
including text, buttons,

panels, images, etc.
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An aqua panel is placed on the canvas. The Object Inspector displays the set-
tings for the panel. 

2 In the Object Inspector, set the Height of the panel to 30

3 Set the Width of the panel to 100. 

4 Click the panel to apply the new dimensions.

Set the Widt
100 pix

Scroll down to see
the Position

settings

Set the Height to
30 pixels.

Set the Width to
100 pixels.
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5 Set SourceCount to 1.

This allows only one copy of the source panel to be dragged to a destination 
panel, rather than an unlimited number of them.

6 Right-click the panel, then select Copy. 

7 Click the canvas to deselect the panel.

If you paste the copied panel when the panel is selected, the new panel will 
be pasted within the original panel. 

8 Right-click the canvas, then click Paste to create a copy of the source panel 
on the item canvas. 

9 Click the canvas again to deselect the new panel, right-click, then select 
Paste.

 You now have three identical source panels.

10 Drag the panels and align them, evenly spaced, along the bottom of the can-
vas, as shown below.

11 To add text to a source panel, select the panel, click Caption in the Object 
Inspector, and in the text box type the text.
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Type the text as shown below

To make destination panels

1 Click Destination Panel , then click on the Canvas.

The text, place here, is already written in the panel.

2 Change the Width to 100 and the Height to 30 as you did with the Source 
Panels.

3 Copy the destination panel twice, as you did the source panels. 

4 Drag the destination panels so they are aligned and evenly spaced along the 
left side of the canvas, as shown below.

To add the text

You will need 1 text box and 3 plain panels for this Drag & Drop GGI project. 
The text box is for the stem for the item. The three panels are for the options for 
the destination panels.

1 On the Components toolbar, click Text , then click the top, left corner of 
the canvas.

A text label is placed on the canvas.

2 In the Object Inspector, click Font, then click the settings  button.

The Font dialog box opens.



CHAPTER 5: BENCHMARK 4.0 EXERCISES
Exercise 6: Creating a Drag & Drop Item

81

3 Change the font to Arial, bold, 11 point, then click OK.

The typeface in the label changes.

4 In the Object Inspector, click WordWrap so the check mark appears in the 
box.

5 Click AutoSize so the check mark is removed from the box.

6 Set the Height to 40 and the Width to 320.

7 Click Caption, then type Place the correct order next to the steps 
for making a telephone call.

8 Click Panel  on the Components toolbar, then click to the right of the 
top destination panel.

9 In the Object Inspector, click Font, then click the settings  button.

10 Set the Font to Arial, 11 points, regular, and the color to white, then click 
OK.

11 Set the Height to 30 and the Width to 200.

12 Set the Color to Navy.

This is the background color. Make sure you select the color field above 
Font, not below it.

13 Set the Alignment to taLeftJustify.

14 Copy the panel two times as you did the source and destination panels.
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You now have three panels.

15 Drag the labels so they are aligned with the destination panels.

16 Type the Caption text for each panel as shown below.

To change the aliases of the panels

To help in scoring, the Alias parameter for each panel needs to be named. 

1 Select a panel, then inside the Object Inspector, type the alias names in the 
Alias field as indicated in the following illustration.

To add subheadings to the GGI

1 Click Text  on the toolbar.

2 Click above the “Listen for the dial tone” panel.

The label will be placed at the location you clicked. You may need to move 
panels to make room for the label.

3 In the Object Inspector, click Caption.

4 Delete the contents and type Steps.

5 Set the font to 10 pts, Arial, Bold.

6 In the Object Inspector, click Color (located under Alignment), then click 
Silver.

Listen

Enter

Pick

Second

First

Third
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7 Center the label over the “Listen for the dial tone” panel.

8 Copy the Steps subheading and paste it centered above the “Second” panel.

9 Click Caption in the Object Inspector, delete Steps and type Order.

To add a Done button to the GGI

1 From the Components toolbar, click the Button  tool, then click any-
where on the GGI canvas. 

This adds a button to the canvas. The Object Inspector displays the settings 
for the button.
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2 Drag the button to the bottom-right corner of the canvas.

To add a caption to the canvas

1 Click the canvas.

2 In the Object Inspector, click Caption, then in the text box type Drag & 
Drop.

The text appears in the title bar at the top of the canvas.

To size the GGI canvas

You can size the canvas by clicking and dragging the canvas border or by setting 
the Width and Height parameters in the Object Inspector. Size the canvas so that 
it is as small as possible, but not so small that any of the elements in the project 
are not fully within the window. You may need to reduce the space between pan-
els, labels, and the Done button. Do not make the canvas larger than 560 pixels 
(width) by 400 pixels (height).

To Close the GGI Tool and return to the item

1 Click OK  to save the image and close the GGI Tool.

The Resource Name dialog box opens. 

2 Type a name for the resource. 

Resource names must follow the 8.3 naming convention. A rule of thumb is 
to use the Item ID in the name. For example, type BM131 if the item ID is 
BM.1.3.1.

The GGI project opens on top of the original item screen.

3 Drag the source panels to the correct destination panels. 

4 Click Done.

A Confirm dialog box opens.

5 Click Yes to accept the results as the correct answer for the item.

This adds an option containing the text string to your item just below the 
stem. Don’t worry about interpreting or understanding the text string.
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To preview the item

1 Click Preview . 

A preview version of the item opens. 

2 Click the Task button.

3 When the GGI project opens, drag the source panels to the correct 
destinations.

4 Click Done.

Verify the Scoring

1 Right-click anywhere in the item and click Score. 

The score box should indicate that your answer was correct. 

2 Click OK to close the score box.

To ensure incorrect responses are scored correctly, place the source panels 
on incorrect destination panels.

3 Click End Preview  to exit preview mode.

To finish up

1 In the Property Inspector, click References > settings . 

2 Click Add.

3 Select Chapter 1: How to make a telephone call: Telemarketing 101.

4 Type page 17 in the text box.

5 Click Finish

6 Click the Audits tab. 

A list of audits appears. The first check box, Item Written, is empty, indicat-
ing that it is the current status of the item.

7 To indicate that the Item Written stage is complete, click the box next to 
Item Written. 

A check mark appears, indicating that that step is complete.
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Chapter 6

Technical Review

When you have completed the item development for the examination, use the fol-
lowing list to determine if you have completed each aspect of each item.

Technical Review Criteria
• Congruence

� Cognitive congruence

� Technical congruence

• Difficulty level

� 1 foot level vs. 5 foot level test

• Relevance

� Does the test taker need to know this to be successful on the job?

• Are the keys truly correct?

• Are the distractors plausible?
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